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Introducing	a	background	blur	to	your	photos	can	draw	attention	to	a	specific	subject,	such	as	an	individual	in	a	portrait	or	an	item	in	a	still	life,	while	adding	a	professional	flair	to	your	image.	This	beautiful	background	blur,	also	known	as	bokeh,	can	be	achieved	even	after	shooting	your	photo,	thanks	to	advances	in	editing	software.	This	guide	will
walk	you	through	the	process	on	iOS,	Android,	Windows,	and	MacOS.	Connects	Ltd	Blurring	photos	on	iOSIf	you	haven’t	taken	your	photograph	yet,	you	can	use	Portrait	Mode	to	automatically	blur	the	background.	Note	that	while	this	can	sometimes	work	for	other	subjects,	it’s	best	for	photos	of	people.	But	if	you	didn’t	shoot	the	photo	in	Portrait
Mode,	you	can	create	the	effect	after	the	fact	using	an	app.	We	like	Blur	Photo	Editor	Background	by	Connects	Ltd.	in	the	App	Store,	which	allows	you	to	edit	photos	with	high	levels	of	precision	—	but	it	does	require	a	$5-per-month	subscription.	Step	1:	Grant	permission	to	access	photos,	then	select	the	photo	you	wish	to	alter.	Step	2:	Click	the
Portrait	button	in	the	lower-right	corner.	Step	3:	Drag	your	finger	over	the	subject	you	wish	to	keep	in	focus.	Step	4:	If	needed,	adjust	the	Intensity	and	Brush	Size	sliders	to	better	aid	your	task.	Step	5:	Once	finished,	select	the	Check	Mark	icon	in	the	lower	right.	Step	6:	Click	the	Save	button	in	the	upper-right	corner	to	save	your	work.	Judi	Studio
Blurring	photos	on	AndroidSome	Android	phones,	such	as	Samsung’s	Galaxy	lineup,	offer	similar	Portrait	Mode	abilities	to	the	iPhone	for	automatically	blurring	the	background	of	your	photographs.	Otherwise,	if	your	phone	doesn’t	provide	the	capacity	within	the	stock	camera	app,	we	would	recommend	downloading	the	Auto	Blur	Background	app	by
Judi	Studio	from	the	Google	Play	Store.	Once	you	have	the	app	installed,	follow	these	steps:	Step	1:	Click	the	large	Portrait	button.	Step	2:	Grant	permission	to	access	photos,	then	select	the	photo	you	wish	to	alter.	Step	3:	The	app	will	then	immediately	analyze	and	blur	your	background	automatically.	You	can	also	select	the	Focus	option	(bottom	left
corner)	to	manually	focus	and	blur	certain	parts	of	your	photo	using	the	Draw	and	Eraser	tools.	Step	4:	Tap	the	Blur	icon	and	adjust	the	slider	to	increase	or	decrease	the	intensity	of	your	blur,	then	tap	the	Back	Button	Arrow	icon.	Step	5:	Once	finished,	select	the	Save	icon	in	the	lower-right	corner	to	save	your	work.	Note:	If	you	wish	to	blur	a
background	without	a	person	using	the	Auto	Blur	Background	app,	once	the	application	is	open,	tap	on	the	Landscape	or	Shape	options	instead	of	Portrait.	Matan	Segev	/	Pexels	Blurring	photos	on	Windows/MacOSWhile	Windows	and	MacOS	both	contain	simple	apps	to	add	background	blur	to	images,	we’ll	be	focusing	on	using	one	of	the	most
popular	photo	editing	packages	available	—	Adobe	Photoshop.	If	you	would	rather	use	a	different	application,	you	can	see	our	list	of	the	best	Photoshop	alternatives.	Otherwise,	once	Photoshop	is	installed	on	your	machine,	follow	these	steps	to	introduce	a	simple	background	blur	to	your	image.	Step	1:	Open	the	photo	you	wish	to	alter	in	Photoshop
(File	>	Open).	Step	2:	On	the	right	side	of	the	screen,	under	the	Layers	section,	right-click	your	photo	and	select	Duplicate	Layer.	Step	3:	Ensure	the	top	layer	in	the	Layers	section	is	chosen,	then	apply	a	Gaussian	Blur	filter	(Filter	>	Blur	>	Gaussian	Blur).	For	the	current	radius,	enter	50,	then	click	OK.	Step	4:	Next,	select	the	Erase	tool	in	the	left-
hand	toolbar.	You	may	wish	to	adjust	the	hardness	of	the	tool	to	around	50%	using	the	top	toolbar.	Step	5:	Begin	to	erase	the	areas	that	you	wish	to	be	clear	and	sharp.	Take	your	time,	as	the	process	may	take	a	bit	of	patience.	Step	6:	If	needed,	adjust	the	size	of	your	erase	tool	as	you	work,	using	the	Size	adjuster	in	the	top	toolbar	—	this	will	allow
you	to	work	on	finer	details.	Step	7:	Save	the	image	(File	>	Save).	You	may	also	want	to	export	a	smaller	version	for	the	web	or	social	media	(File	>	Export	>	Export	As…).	Tip:	While	working,	you	can	change	the	opacity	of	the	blurred	layer	to	see	fine	details	better	below.	Achieve	this	by	clicking	on	the	layer	in	the	Layers	section,	then	using	the
Opacity	selector.	Remember	to	return	this	setting	to	a	higher	number	once	finished.	This	is	one	of	the	simplest	and	fastest	ways	to	blur	a	background	in	Photoshop,	but	it	won’t	be	the	most	realistic.	If	you	want	more	control	over	the	blur	in	your	photo,	complete	with	the	ability	to	simulate	depth-of-field	falloff,	see	our	tutorial	on	Photoshop’s	Field	Blur
tool.	screenshot	Fast	blurring	with	web	app	FotorIf	you	don’t	want	to	download	and	learn	a	new	app	or	you’re	short	on	time,	you	can	also	visit	a	web	app	for	quick	blurring	on	a	photo	you’re	working	on.	We	recommend	the	app	Fotor	for	this	particular	project.	Click	the	link	to	visit	the	web	app	and	get	started.	Step	1:	Select	Open	Image	on	the	top
menu	to	upload	your	photo.	Step	2:	Go	to	the	Adjust	menu	on	the	left-hand	side.	Then	scroll	until	you	see	Advanced	Edits.	Step	3:	Under	Advanced	Edits,	you've	got	two	options:	Blur	and	Blur	-	Brush.	Blur	is	more	of	an	autofocus	feature	where	you	can	choose	between	Circular	or	Linear	focus	and	quickly	drag	that	focus	around	to	where	you	want	the
focus	to	be,	blurring	everything	else	outside	of	it.	In	Blur,	you	can	also	adjust	the	size	of	the	focus	area	and	the	blur's	intensity.	When	you're	done	adjusting	click	Apply.	Blur	—	Brush	is	more	like	a	manual	focus.	It	gives	you	more	control	and	lets	you	fine-tune	the	details	with	customizable	Brush	and	Eraser	tools.	But	it	can	take	longer	to	use	depending
on	how	much	you	want	to	blur	and	it's	a	premium	feature	meaning	you'll	have	to	sign	up	for	a	paid	account	(at	least	a	free	trial)	to	remove	the	watermark.	The	regular	Blur	feature	is	free	and	doesn't	have	a	watermark.	Step	4:	When	finished,	click	the	blue	Download	button	in	the	top	right	corner.	You'll	be	prompted	to	sign	up	for	a	free	account	in
order	to	download	your	edited	photo.	Editors'	Recommendations	Blur	can	be	used	as	a	way	to	conceal	parts	of	the	image	you	don't	want	the	viewer	to	see	or	to	highlight	a	certain	part	of	the	image	by	making	it	a	focal	point	of	the	picture.	Even	though	it	is	probably	best	to	use	a	photo	editing	software	to	blur	images	and	image	backgrounds	,	this	task
can	be	accomplished	with	a	number	of	programs	you	wouldn't	normally	associate	with	photo	editing.	If	you	don't	want	to	spend	a	significant	amount	of	money	on	a	professional	photo	editing	software,	you	can	use	some	of	the	programs	commonly	featured	on	Windows	OS	to	blur	images	for	free.	In	this	article,	we	will	show	you	how	you	can	accomplish
this	in	just	a	few	simple	steps.	Besides	the	photo	editing	program,	Fotophire	Slideshow	Maker,	a	photo	and	video	slideshow	maker,	can	help	you	to	combine	multiple	photos	ino	a	slideshow,	and	it	enables	you	to	get	the	work	done	in	3	simple	steps.	If	you	are	using	a	Mac	computer,	you	can	click	here	to	get	the	information	about	how	to	blur	image
background	on	Mac	Wondershare	Fotophire	Editing	Toolkit	Enables	you	to	apply	more	than	200	effects	to	your	photos	to	make	them	better.	Crop	or	cut	pictures	to	the	size	to	meet	any	of	your	need.	Help	you	to	remove	any	unwanted	objects	from	your	photos.	Allow	you	to	use	the	Creative	Blur	to	refocus	your	photos	in	a	click.	How	to	blur	images	on
Windows	with	Paint	Microsoft	Paint	was	featured	on	the	first	version	of	Windows	ever	created	and	it	has	been	included	on	every	new	version	of	this	OS	since	1985.	Paint	doesn't	offer	a	Blur	setting,	but	it	is	still	possible	to	blur	an	image	with	this	software	in	two	different	ways.	Method	1:	Blur	Images	by	Resizing	Selected	Area	Import	the	photo	you'd
like	to	blur	and	then	click	on	the	Select	tool	in	the	toolbar.	Proceed	to	select	the	area	of	the	image	you	want	to	blur.	Drag	the	edge	of	the	rectangle	you	just	made	to	resize	the	selected	area.	You	should	aim	to	make	the	Select	tool	rectangle	as	small	as	you	possibly	can.	Drag	the	rectangle	outward,	and	the	selected	area	should	become	pixelized	enough
to	blur	the	designated	area	of	the	image.	Repeat	this	step	until	you	get	a	result	you	are	satisfied	with.	Method	2:	Blur	Images	by	Filling	Colors	Launch	the	software	and	import	the	photo	you'd	like	to	blur,	by	clicking	on	the	Open	option	in	the	File	menu.	Select	the	Rectangle	tool	from	the	Shapes	menu.	Create	a	transparent	rectangle	around	the	object
you'd	like	to	blur	and	then	click	on	the	Color	2	feature	to	choose	the	color	of	the	blur.	Once	you've	selected	the	color,	click	on	the	File	menu	and	pick	one	of	the	options	provided	such	as	Crayon,	Natural	Pencil	or	Oil.	If	you	like	the	blur	effect	you	created	click	on	Save	to	complete	the	process.	How	to	blur	images	on	Windows	with	MS	Office	The
feature	that	enables	you	to	blur	images	is	only	available	in	MS	Office	2010	or	later,	so	if	you	have	an	older	version	of	this	software	package	you	need	to	upgrade.	Copy	and	paste	your	photo	into	an	Office	document	and	click	on	it	to	select	it.	Afterwards,	go	to	the	Picture	Tools	Format	tab	and	click	on	the	Artistic	Effects	drop-down	menu.	Once	you've
applied	the	blur	effect	to	the	image	you	can	adjust	it	by	clicking	on	the	Artistic	Effect	Options	feature.		How	to	Blur	the	Background	of	Photos	on	Windows	with	MS	Office	The	process	of	blurring	the	background	of	a	photo	is	pretty	simple	in	MS	Office,	even	though	photo	editing	isn't	what	this	software	package	is	famous	for.	In	order	to	commence	the
process	of	blurring	the	background	of	a	photo	you	first	need	to	import	it	into	one	of	the	programs	featured	in	the	MS	Office	package.	After	you	imported	the	picture	into	the	software,	you	can	crop	the	photo,	or	resize	it	so	it	fits	perfectly	into	the	document	you	are	creating.	Then	create	a	copy	of	the	image	you	are	working	on	and	once	you	have	two
photos	proceed	to	blur	the	background	image.	Select	the	picture	to	which	you	want	to	apply	the	blur	effect	and	then	head	over	to	the	Picture	Tool	Format	tab,	and	follow	the	steps	for	blurring	the	photo	described	in	the	previous	section	of	this	article,	but	make	sure	to	apply	the	blur	effect	to	the	entire	photo.	Now	that	your	background	photo	is	ready,
proceed	to	remove	the	background	from	the	second	image.	In	order	to	do	this	you'll	need	to	select	the	photo,	and	then	once	again	go	to	the	Picture	Tool	Format	tab,	and	click	on	the	Remove	Background	feature	in	the	Adjust	group.	If	the	foreground	of	the	image	is	clearly	distinguishable	from	the	background,	the	software	will	automatically	isolate	the
object	in	the	foreground.	However,	if	this	doesn't	happen,	you	can	use	Mark	Areas	to	Keep	and	Mark	Areas	to	Remove	tools	to	precisely	highlight	the	areas	of	the	image's	background	you	want	to	remove.	Click	on	the	Keep	Changes	button	to	remove	the	background	of	the	photo.	Cut	and	paste	the	image	from	which	you	removed	the	background	onto
the	photo	to	which	you	applied	the	blur	effect	and	adjust	the	size	of	the	foreground	image	so	it	fits	nicely	into	the	second	picture.	How	to	blur	the	Background	of	Photos	on	Windows	10	with	Photos	App	You	really	don't	have	to	be	an	image	editing	expert	to	blur	photo	background	with	the	Photos	app	on	Windows	10,	because	this	app	will	enable	you	to
perform	this	task	in	just	a	few	simple	steps.	Since	the	Photos	app	is	the	default	software	for	viewing	photos	on	Windows	10,	all	you	need	to	do	is	double-click	on	the	photo	in	a	folder	to	start	the	process	of	blurring	its	background.	Once	the	photo	is	displayed	in	the	Photos	app,	click	on	the	edit	button,	located	at	the	top	of	the	screen	and	then	select	the
Effects	feature.	More	recent	versions	of	the	app	don't	provide	the	Selective	Focus	option	so	you	can	just	apply	the	Vignette	feature	to	your	Whichever	of	these	two	effects	you	apply	to	your	image	you'll	need	to	move	them	around	to	find	the	perfect	position	for	them	on	your	photo	and	then	you	should	adjust	the	settings	so	that	the	background	of	your
photo	is	perfectly	blurred.	Besides	achieving	blur	effects	on	computer,	you	can	now	add	blur	effects	on	your	smartphones,	no	matter	you	are	using	an	iOS	or	an	Android	system.
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